©2004 by Information Technology, Goucher College

All rights reserved. No part of this booklet may be used or reproduced in any form or by any means, or stored in a database or retrieval system, without prior written permission of the publisher except in the case of brief quotations embodied in critical articles and reviews. Making copies of any part of this booklet for any purpose other than your own personal use is a violation of United States copyright laws. This booklet is intended for use as a reference for faculty, staff and students of Goucher College who have or will be attending instructor led training. For information write to Goucher College, Information Technology, 1021 Dulaney Valley Road, Baltimore, Maryland 21204-2794.
# Table of Contents

**Special Notations and Symbols** ................................................................. iv

**Chapter One: Getting Started** ................................................................. 1

- Database and Table Design ...................................................................... 2
- Creating a New Blank Database ................................................................. 4
- Introduction to Tables .............................................................................. 6
- Understanding Records and Fields .......................................................... 6
- Creating a Table ....................................................................................... 7
  - Using Design View .............................................................................. 7
- Using Datasheet View ............................................................................ 9
  - Closing a table .................................................................................. 10
- Opening a Table ..................................................................................... 11
  - In Datasheet View ............................................................................ 11
  - In Design View ................................................................................ 11
- Closing the Database ............................................................................ 11
- Opening a Saved Database .................................................................. 12
  
  Exercise: Chapter One ....................................................................... 13

**Chapter Two: Working with Data** ......................................................... 14

  - Using the Keyboard ........................................................................... 15
  - Entering New Records ...................................................................... 16

- Editing Records .................................................................................... 16
  - Undoing an Editing Change .............................................................. 17
- Deleting a Record ................................................................................ 17
- Sorting .................................................................................................. 17
- Finding Information ............................................................................. 18

- Customizing the Table in Design View ................................................... 19
  - Deleting Fields ............................................................................. 19
  - Renaming Fields ........................................................................... 19
  - Rearranging Fields ....................................................................... 20
- Changing Field Sizes .......................................................................... 21
  - Text Fields .................................................................................... 21
  - Numeric Fields ............................................................................... 22
- Setting Properties ................................................................................ 23
  - Decimal Places ............................................................................... 23
• Default Values........................................................................................................23
• Date Formats..........................................................................................................23
  
  Exercise: Chapter Two..........................................................................................24

Chapter Three: Relationships ..................................................................................25
  What is a Relationship? .........................................................................................26
  Displaying the Relationships Window .................................................................26
  Creating Relationships .........................................................................................27
  Editing Relationships ...........................................................................................28
  Deleting Relationships .........................................................................................28
  
  Exercise: Chapter Three .....................................................................................29
# Special Notations and Symbols

<table>
<thead>
<tr>
<th>Notation</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keystroke</td>
<td>🔄Enter</td>
<td>Press Enter on the keyboard</td>
</tr>
<tr>
<td>Button/Mouse</td>
<td>OK</td>
<td>Click on OK in the current window</td>
</tr>
<tr>
<td>Menu Item</td>
<td><strong>Tools, Options</strong></td>
<td>Go to the Tools menu and select Options.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Notation</th>
<th>Graphic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Saving Shortcut</td>
<td><img src="clock.png" alt="clock" /></td>
</tr>
<tr>
<td>Hot Tip!</td>
<td><img src="pepper.png" alt="pepper" /></td>
</tr>
<tr>
<td>Caution!</td>
<td><img src="exclamation.png" alt="exclamation" /></td>
</tr>
</tbody>
</table>
Chapter One: Getting Started

In this chapter, learn how to …

- Discuss the concept of a relational database.
- Identify the types of objects in an Access 2003 database.
- Create a table manually in both design view and datasheet view.
- Open, close and navigate between tables.
- Complete a training exercise.
Database and Table Design

A database in Access is a collection of tables, queries, forms, reports, pages, macros, and modules. Each one of these items is considered an object.

Design Questions

- What is the purpose or goal of the database?
- Based on the purpose, what information do you need to include? (The information you will need to include will become fields.)
- How can you group the information together into tables?
- Are the tables related in any way? If so how are they related? (Do you have one table with information about contacting customers and one table dealing with all customer purchases?)
- Which field will be unique in each table? (This is also called the primary key. Most tables have a field that is unique for each record.)
Examples of Design Questions

Let’s examine the questions above for a specific situation:

- The purpose of the database will be to keep track of information for a conference.

- Information to include: Conference Events, Cost per person for the Event, Contact Name, Address, Phone Number, Location of the Event, Date of the Event, Number of Tickets Reserved by the Contact, Date of Reservation, Amount Paid by Contact, Which Event the Reservations are for, and How Many Spaces are Available per Event.

- Grouping the information together, it would make sense to group the information into three tables: Client Contact Information, Event information, and Reservation Information.

<table>
<thead>
<tr>
<th>Client Contact Information</th>
<th>Event Information</th>
<th>Reservation Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact ID</td>
<td>Event ID</td>
<td>Reservation ID</td>
</tr>
<tr>
<td>Name</td>
<td>Name</td>
<td>Contact ID</td>
</tr>
<tr>
<td>Address</td>
<td>Location</td>
<td>Event ID</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Start Date</td>
<td>Date</td>
</tr>
<tr>
<td>Business Name</td>
<td>Finish Date</td>
<td>Amount Paid</td>
</tr>
<tr>
<td></td>
<td>Space Available</td>
<td># Spaces Reserved</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cost/Person</td>
</tr>
</tbody>
</table>
The table about reservations is related to both the Events Table and the Contact Table. It is related by having the Contact ID and the Event ID as part of its fields. You don’t want to make reservations unless you know who the contact is and which event the reservations are for.

The unique field in the contact table will be the contact ID. The unique field in the events table will be the Event ID, and the for the reservations table, it will be the Reservation ID.

**Creating a New Blank Database**

**STEPS**

1. Either selects New from the File menu or use the **NEW** button on the toolbar.
2. Double-click on the Blank Database icon.
3. You will be prompted to name the database at this time. Select the drive or folder where you want to store the database and type in a file name.
4. Click the **CREATE** button.
There are seven different types of objects that comprise an Access database.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABLES</td>
<td>These contain the database data. Queries, forms, and reports are all built from tables.</td>
</tr>
<tr>
<td>QUERIES</td>
<td>A view of the data stored in tables, which limits the information to specific criteria.</td>
</tr>
<tr>
<td>FORMS</td>
<td>A view of the data stored in tables which lays the fields out on the screen rather than in a table format.</td>
</tr>
<tr>
<td>REPORTS</td>
<td>A view of the data stored in tables which is formatted for printing.</td>
</tr>
<tr>
<td>PAGES</td>
<td>A special type of web page used to view of edit data stored in an Access database, an SQL database, or an Excel spreadsheet.</td>
</tr>
<tr>
<td>MACROS</td>
<td>A series of steps automated under a single command.</td>
</tr>
<tr>
<td>MODULES</td>
<td>Visual Basic programming code used to further customize the look and operation of a database.</td>
</tr>
</tbody>
</table>
Introduction to Tables

Once you know what information is required for your database you can create a table. Tables are the building blocks of the database, since they are where all of the information is stored.

Understanding Records and Fields

When you create a table, it is important to understand the difference between records and fields. The **FIELDS** will make up the columns headers of your new table and the **RECORDS** will become the rows of information created through data entry. It is the fields that are designed by you.
Creating a Table

Using Design View

Design View provides the most control over what fields are included and what type of information can be entered.

STEPS

1. If necessary, select Tables from the Objects List.

2. Double-click on Create table in Design View.

3. Type in the name of a field.
Using the \textbf{Enter} or \textbf{Tab} keys, move to the next cell and choose a \textbf{Data Type} for the field from the drop-down list (see table).

The description is optional. Any text entered in this area will be displayed on the status bar when the user moves into this field on the toolbar.

When all the fields are added, select a field that will serve as the \textbf{Primary Key} (a unique identifier for each record entered in the table) and click on the \textbf{KEY} button on the toolbar.

\begin{table}[h]
\centering
\begin{tabular}{|l|l|}
\hline
\textbf{Data Type} & \textbf{Description} \\
\hline
Text & Up to 255 characters. \text{[94x59]} \\
Memo & Up to 64,000 characters. \text{[94x59]} \\
Number & Numerical entries only. \text{[94x59]} \\
Date/Time & Date/Time formats only. \text{[94x59]} \\
Currency & Formats numeric entries to currency. \text{[94x59]} \\
AutoNumber & Sequentially numbers each row \text{[94x59]} \\
Yes/No & Requires the user to signify either a yes or no response only. \text{[94x59]} \\
OLE & Allows linking or embedding to other programs types. \text{[94x59]} \\
Hyperlink & Formats entries to be used as a web link. \text{[94x59]} \\
Lookup Wizard & Creates a list of entries for the user to pick from. \text{[94x59]} \\
\hline
\end{tabular}
\end{table}

\textbf{Hot Tip!} If you have not set a Primary Key before saving or exiting the Table, you will be prompted by Access to set one. If you allow Access to set the Primary Key for you, another field will be added to your table named “ID” and set to an AutoNumber Data Type.\text{[94x59]}
Save the table by clicking **SAVE** button on the toolbar. Enter the name for the table at the prompt.

If you exit the table or attempt to move to Datasheet View, you will also be prompted to save if any changes have been made.

---

**Using Datasheet View**

This method is only recommended for small, uncomplicated tables from this view.

**STEPS**

1. If necessary, select **Tables** from the Objects list.
2. Double-click on **Create Table** by entering data.
3. Double-click on the **Field1** heading and then rename it.

Continue to rename fields until complete.
6 Fill in your first record. Access assigns a Data Type based upon the type of data you enter.

6 Save the table.

**Closing a Table**

You can close a table from either Design View or Datasheet View by either:

- Selecting **Close** from the **File** menu.
- Clicking on the **CLOSE** button in the upper right corner of the table window.
Opening a Table

When opening a table, you need to decide whether to open it in Design View to edit the fields, or Datasheet View to edit the data.

**In Datasheet view**
You can open a table in Datasheet View by either:
- Double-clicking on the table from the database window.
- Selecting the table from the database window by clicking on the OPEN button

**In Design View**
You can open the table directly in Design View by selecting the table from the database window and clicking on the DESIGN button.

Closing the Database

You can close the database by either:
- Choosing CLOSE from the FILE menu.
- Clicking on the CLOSE button of the database window.
- Opening another database (there can only be one database open at a time).
Opening a Saved Database

You can open a saved database by either:

- Clicking on the OPEN button on the toolbar.
- Choosing OPEN from the FILE menu.

<table>
<thead>
<tr>
<th>Time Saver!</th>
<th>Because only one database can be open at a time, you don’t have to close an open database before you can open the next one.</th>
</tr>
</thead>
</table>
Exercise One

Your department is setting up a new database to keep track of what times are purchased and purchases them.

1. What information would you include in the database? (List between 5 and 10 items) (Page 3).

2. Create a new blank database. Store it in your class files under the folders "Access 2000 Classes\Access 2000 Tables", and name it Department Purchases (Page 5).

3. Create a table in design view including the following fields (choose appropriate data types) (Page 8):
   - Invoice#
   - Date
   - Item
   - TotalCost
   - EmployeeID
   - Vendor

4. Make the Invoice # the primary key (Page 9).

5. Close the table and name it Invoice Information (Page 12).

6. What is the definition of a Primary Key? (Page 9). Write your answer below:

________________________________________________________________________
________________________________________________________________________
Chapter Two: Working with Data

In this chapter, learn how to …

- Enter data in a table
- Navigate using the keyboard and the mouse
- Select text for editing using different methods
- Delete records
- Customize the table design
- Complete a Training Exercise
Navigation

To move between records with the mouse, use the Navigator Bar in the lower left corner of the window.

CAUTION!

If the Navigator Bar is not displayed, maximize the window.

Using the Keyboard

You can also easily navigate using the keyboard (See table below.)

<table>
<thead>
<tr>
<th>Name</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Record</td>
<td>![left arrow]</td>
<td>1st Record in the database</td>
</tr>
<tr>
<td>Previous Record</td>
<td>![left arrow]</td>
<td>Record above the one currently being viewed. You can use the Go To box by either double-clicking inside, using F5 on the keyboard, or using Go To from the Edit menu. Type in the number of the record and press (Enter button) on the keyboard</td>
</tr>
<tr>
<td>Go To/Record Number</td>
<td>![progress bar] 1</td>
<td></td>
</tr>
<tr>
<td>Next Record</td>
<td>![right arrow]</td>
<td>Last record in the database</td>
</tr>
<tr>
<td>Last Record</td>
<td>![right arrow]</td>
<td>Last Record in the database</td>
</tr>
<tr>
<td>New Record</td>
<td>![star]</td>
<td>Below the last record of the database and creates a new record for input.</td>
</tr>
<tr>
<td>Keystroke</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Tab&lt;&gt;</td>
<td>Right</td>
<td></td>
</tr>
<tr>
<td>↑ Shift Tab&lt;&gt;</td>
<td>Left</td>
<td></td>
</tr>
<tr>
<td>Home</td>
<td>Beginning of a row</td>
<td></td>
</tr>
<tr>
<td>End</td>
<td>End of a row</td>
<td></td>
</tr>
<tr>
<td>Ctrl Home</td>
<td>First row, First column</td>
<td></td>
</tr>
<tr>
<td>Ctrl End</td>
<td>Last row, Last column</td>
<td></td>
</tr>
</tbody>
</table>

**Entering New Records**

To enter a new record, use the **NEW RECORD** button on The toolbar or the Navigator Bar.

**Editing Records**

**Replacing Cell Contents**

To replace the contents of a cell, select the entire cell and type in the new text.

**Editing Part of a Cell**

To edit only part of a cell’s contents, click once inside the cell to get an insertion point (blinking line), then edit as usual.

| Time Saver! | You can toggle between selecting the whole cell or an insertion point using the F2 key on the keyboard. |

---

16  Access I: Tables & Relationships
Undoing an Editing Change

If you make a mistake you can quickly undo it.

- Use the UNDO command from the toolbar or the Edit menu.

- Press the Esc on the keyboard before exiting the cell.

<table>
<thead>
<tr>
<th>CAUTION!</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo only works from your last action. Access saves the table information as you work so you cannot close without saving changes! You should back up your database on a regular basis.</td>
</tr>
</tbody>
</table>

Deleting a Record

You can delete an entire record using the DELETE RECORD button on the toolbar.

Sorting

To sort the contents of the table, place the insertion point anywhere in the field to be sorted and use the SORT ASCENDING or SORT DESCENDING buttons on the toolbar.
Finding Information

You can also find the specific records based on content by using **Find** from the **Edit** menu or the **FIND** button. The Find Dialogue Box will open:

If the **Find Box** gets in the way, close the box and use the [Shift] [F4] key to continue to **Find Next**.
Customizing the Table in Design View

Adding Fields
You can add a new field to your table by either:

- Inserting a new row into the middle of the table design grid by selecting the row and using the **INSERT ROW** button on the toolbar. The new field will be inserted above the row that is selected.

- Typing in the new field information at the bottom of the table design grid.

Deleting Fields
You can delete a field from the design grid using the **DELETE ROW** button on the toolbar.

| CAUTION! | The data stored in the field will be deleted permanently as well. |

Renaming Fields
To rename a field, select the field name in the design grid and replace it by typing in the new name.

Rearranging Fields
If you decide that the fields should be arranged in a different order, you can move them.
STEPS

1. Select the entire row of the field(s) to be moved using the **ROW MARKER**.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>OrderID</td>
<td>AutoNumber</td>
</tr>
<tr>
<td>CustomerID</td>
<td>Number</td>
</tr>
<tr>
<td>ProductID</td>
<td>Number</td>
</tr>
<tr>
<td>OrderDate</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Qty</td>
<td>Number</td>
</tr>
</tbody>
</table>

2. Release the mouse.

3. Drag the highlighted row marker to the desired location.

4. Release the mouse.
Changing Field Sizes

FIELD SIZE is important because it affects the size of the database.

**Text Fields**

**STEPS**

1. Select the text field to be modified from the top of the table design grid.
2. Highlight the current FIELD SIZE from the FIELD PROPERTIES at the bottom of the pane of the design grid.
3. Type in the desired size. (see table in “Numeric Fields”)

| CAUTION! | The maximum size is determined by data type. |
**Numeric Fields**

**STEPS**

1. Select the numeric field to be modified from the top of the table design grid.

2. Click on the current **Field Size** from the **Field properties** at the bottom of the pane of the design grid and then click down arrow that appears.

3. Select the desired size from the list of available options.

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte</td>
<td>Stores whole numbers from 0 to 255 and uses 1 byte.</td>
</tr>
<tr>
<td>Integer</td>
<td>Stores whole numbers from -32,768 to 32,767 and uses 2 bytes</td>
</tr>
<tr>
<td>Long Integer</td>
<td>(Default) Stores whole numbers -2,147,483,648 to 2,147,483,647 and uses 4 bytes.</td>
</tr>
<tr>
<td>Single</td>
<td>Stores numbers with up to 7 digits of precision and uses 4 bytes.</td>
</tr>
<tr>
<td>Double</td>
<td>Stores number with up to 15 digits of precisions and uses 8 bytes.</td>
</tr>
</tbody>
</table>
Setting Properties

Decimal Places
You can set a field to display a certain number of decimal places in Datasheet View using the decimal place property for a numeric field.

Default Values
When you set a default value in the Field Properties, this becomes the data entered automatically for new records. (This does not mean the value is permanent. It can be changed.)

Date Formats
You can alter the Format property for a date field to abbreviate a date or spell out a date in full, no matter which format is used to enter it. The helps to ensure consistency. This can be done by either:

- Clicking on the current Format property and then clicking on the down arrow to display a list of preset options.
- Typing in the format you desire in the Format property box. For example, you could type out “dd mmmm yyyy” to use numbers for the day and spell out the month and year.
Exercise Two

After evaluating the database that you have set up, you realize that you made some mistakes in data entry and that the design of the table needs to be changed slightly to include a needed field and the correct field properties.

1. Open Practice Department Purchases located in your class files under \Access 2000 Classes\Access 2000 Tables (Page 13).

2. Open the Employees table and move to record 16. Update the record so that the department listed is the department you work in (Page 16, 18).

3. Create a new record and fill in your information (Page 17).

4. Add the field Review Date to the end of the table and change the format to Short Date (Page 20, 23).

5. Change the name of the StartDate field to HireDate (Page 20).

6. Close the table, saving the changes (Page 12).

7. Open the Events table in the design view (Page 12).

8. Select the AvailableSpace field. This field records the maximum number of attendees allowed for each event. If no events will have more than 200 attendees, what would be the appropriate size for this field? __________
   Make this change, then save the changes and close the table (Page 21).

9. When you closed the table in step eight above, you may have gotten an error message such as: “Microsoft Access encountered errors while converting the data. The contents of 1 record were deleted.” Why was this error message generated and how can you fix this problem?
In this chapter, learn how to …

- Relate two tables to each other.
- Edit Relationships.
- Delete Relationships.
- Complete a Training Exercise.
What is a Relationship?

A Relationship is how you tell the program that a piece of information means the same thing in more than one table. For example, Employee #55 in one table is the same as Employee #55 in another table. This may seem obvious to you, but it is not obvious to the program. You must tell it when one #55 matches another #55.

Table relationships can be created between two tables as long as they have a common field (in the example database, Contacts should have a relationship to Reservations because they both contain the field ContactID). Setting the relationship up in Access is very important. Once a relationship is established you can view information from both tables at the same time by creating a query. Forms and reports are built from queries or tables. When you take the step of setting up the relationship, you increase flexibility tremendously.

Relationships are created using a Primary Key from one table and linking it to a related field in another table (now called a Foreign Key).

Displaying the Relationships Window

Use the Relationships button on the toolbar. Or click Tools, Relationships on the menu bar.
Creating Relationships

STEPS

1. Make sure that your tables are closed and that you are at the database screen.

2. Click on the RELATIONSHIPS button.

3. Click on the SHOW TABLE button. (The show table window appears automatically if no relationships have been defined.)

4. Select one of the desired tables in the relationship and click on ADD. Repeat for each table involved in a relationship that you need to set up. Click on CLOSE.

If you close the window and you notice that there are too many tables displayed, right-click on the table you want to remove from view, and select REMOVE TABLE.

5. Drag the related field from the Primary Table (the One side) and drop it directly on top of the same field in the Related Table (the Many side).

6. From the relationships window that appears, click on CREATE.
Editing Relationships

STEPS

1. Open the Relationships window.
2. Double-click on the line connecting the two tables.
3. Make any changes to the dialog box and click OK.

Deleting Relationships

STEPS

1. Open the Relationships window.
2. Click once on the line connecting the two tables. The line will become bold.
3. Press Delete on the keyboard.
Exercise Three

Before you create queries, you need to establish any important table relationship in your database.

1. In your own words, what is required to create a relationship between tables? (Page 26).

2. Open Practice Department Purchases located in your class files under \Access 2000 Classes\Access 2000 Tables. What two table relationships could be established in this database? List the table names and the related field (Page 26).

3. Create at least one of the relationships above (Page 27).